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Rectangular Data File  
 
This exercise uses four transcript files: “AA1Nar.slt”, “AA2Nar.slt”, “AA3Nar.slt” and “AA4Nar.slt”. Each of these 
four transcript files contains a narrative language sample from a typically developing, seven-year-old, African 
American student. You will use the “Rectangular Data File” option in the Tools menu to generate a rectangular 
data file of selected SALT variables for these four sample transcripts. If you have Microsoft® Excel® on your 
computer, the last section of this exercise runs Excel and imports this data file into a spreadsheet. 
 
A. Start the SALT Program 
 

1. The SALT program begins with the Getting Started window. Typically, you begin by creating a new 
transcript or opening an existing transcript. In this exercise, however, you will be using the Tools menu 
so click the Close button to close this dialogue box. 

 
2. Select Tools menu  Rectangular Data File and you are presented with the Rectangular Data File 

dialogue box. 
 

Notice that, by default, no transcripts are selected; the target speaker is the 1st speaker, the substitute for 
missing data is “---” for text data, -1 for integer data, and -1.0 for decimal data, and the only variable button 
to have a gray checkmark preceding it is “General Information”. If the current settings are anything else, 
click the Reset button.  

 
B. Select the Transcript Files 
 

1. Choose Select Transcripts and you are presented with the Select Transcripts dialogue box. 
 

2. Click Browse for Files. Unless you changed the default transcript folder, the My SALT Data\Transcripts 
folder located within your Documents folder is displayed. Open the Samples folder and then the Lesson 
Samples folder. 

 
 
 
 
 
 
 
 
 
 
 
 

3. Select four transcript files: AA1Nar.slt, AA2Nar.slt, AA3Nar.slt, and AA4Nar.slt. You could repeat this 
step four times, once for each transcript, but it is easier to select all four at the same time. There are 
several ways to do this depending on your operating system: 1) hold down the <Ctrl> key on the 
keyboard and click once on each of the four transcript files, 2) click the first file (AA1Nar.slt) and then 
hold down the <Shift> key and click the last file (AA4Nar.slt), or 3) check the box preceding each file. 

 
4. After selecting the four transcript files, click Open and the four transcripts are listed in the dialogue box 

window. 
 

Note: if the default transcript folder has been changed, follow these steps to reset the transcript folder 
to the default setting: 
• Click the Cancel button to close the “Open” dialogue box. 
• Select Setup menu  File locations  Transcripts. The current transcript folder is displayed. 
• Click the Reset button to reset the transcript folder to the default setting. 
• Click OK. 
• You are asked if you want to save the folder setting as the program default. If you select Yes, the 

previous folder setting is lost. If you select No, the change is only in effect until you exit the SALT 
program. Select Yes or No. 

• Select File menu  Open and go back to step 1 (above). 
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5. Click OK to return to the “Rectangular Data File” dialogue box and notice the message “4 transcripts” 
underneath the “Select Transcripts” button. 

 
C. Select the Data Variables 
 

1. View the pre-selected variable - transcript filename. 
 
Notice the small gray checkmark in front of the “General Information” button indicating that one or 
more variables within this group have been selected. 

 
• Select General Information and notice that the transcript filename has been selected. This is the 

only variable that is pre-selected. Click OK. 
 
2. Select some plus line variables. 

 
• Click the Plus Lines button. The variables listed here are taken from the plus lines at the beginning of 

each transcript. They correspond to the plus lines which are automatically inserted when you begin 
a new transcript and fill in the header information. 
 

• Select Gender, CA: (yy;mm), Context, and Subgroup. If you have any questions as to what the 
variables refer to, click the Help button. 

 
The edit window labeled “Other plus line data” is for selecting data from non-standard plus lines. 
Suppose, for example, that some or all of your transcripts have a plus line that identifies the child’s 
school using the label “School”. To be selectable, the plus line label must be followed by a colon and 
the information following the colon is the data. 

   Sample plus line: 
  + School: Washington Middle School 

 
• To select this “other” plus line data, click in the edit window and type School. 

 
• Click OK. The gray checkmark indicates that plus line variables have been selected. 

 
3. Select some Standard Measures Report variables. 

 
• Click the Standard Measures Report button. The variables listed here correspond to the variables in 

the Standard Measures Report located in the Analyze menu.  
 

• Select the following variables:  Total Utterances, Analysis Set Utterances, Elapsed Time (minutes), 
and % Intelligible Words. When you have finished selecting these four variables, click OK. 

 
4. Generate the data set. 

 
• Click Generate Data to generate the data set. 
 

There are five rows in the data set. The first row contains the variable labels followed by one row for 
each of the four selected transcripts. There are ten columns in the data set. The first column is the 
pre-selected filename variable, the next five columns are the plus-line variables, and the last four 
columns are the Standard Measures Report variables. You do not have any control over the order of 
the variable columns. Notice that the school variable is missing for each transcript. Because there 
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isn’t a school plus line in these transcripts, the missing data text is substituted.  
 

5. Display the variable key. 
 

 
• Click Display Key to generate a key to the selected variable labels. The list is displayed behind the 

dialogue box. Click Cancel to close the dialogue box. Notice that each variable is listed along with a 
brief description and the category it was selected from. 

 
• If you want to print the variable key, select File menu  Print. If you want to save it as a PDF, CSV, 

TSV, or TXT file, select File menu  Save. 
 

• Select Window menu  Close All. If prompted to save any of the data sets, click No. 
 

6. Change the format of the current age (CA), remove the plus line School variable. 
 

 
• Select Plus Lines. 
 
• The current age is in years and months. There are three different age formats: yy;mm (years and 

months),  years (as a decimal), and months (as a whole number). Suppose you want current age as 
years.  
Uncheck CA: (yy;mm) and check CA: (in years). Then delete School from the “Other plus line data” 
edit box and click OK. 

 
• Click Generate Data again to generate the new data set. The current age is now in years and there 

are no missing variables. 
 
8. Save the data as a CSV text file. 

 

• Click the save icon  or select File menu  Save or File menu  Save As.... You are presented 
with the “Save as” dialogue box. 
 

• Select CSV – Comma Separated Values (Excel). 
 

• If you have Microsoft® Excel® installed on your computer, check Display report after saving. 
 

• Click OK and you are prompted with the “Save As” dialogue box. 
 
• By default, reports are saved in the My SALT Data\Reports folder within your Documents folder.  

This should be the folder listed. 
 
 
 
 

• Click in the “File name:” box and type the name of the new text file. You may use any name you 
want but, for this exercise, use RDF Results (for Rectangular Data File Results). The text extension 
“.CSV” will be automatically added to the end of the filename. 

Note: although this exercise directs you to save some files in Documents\My SALT 
Data\Reports, you may save them anywhere you want. Just make sure you remember the 
name and location of where you save them. 
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• Click the Save button and your data is saved as a CSV text file in Documents\My SALT Data\Reports.  

 
• If you have Microsoft® Excel® installed on your computer and you checked “Display report after 

saving”, Excel® should open with your data file. Close the spreadsheet. 

9. You have the option of saving the variables which were used to generate this data set. This would be a 
time saver in case you wanted to generate this data set again. 

 

 
• Click the Save button from the left-hand-side of the dialogue box and you are presented with the 

folder My SALT Data\RDF located within your Documents folder. This folder was created during the 
initial setup and is the recommended place to save your rectangular data file selections. Note that 
you can change this default file location in “Setup menu  File Locations  Rectangular Data File 
Selections”. 
 

• Type the name of the new file in the “File name:” box. You may use any name you want but, for this 
exercise, use RDF Selections. The text extension “.SBT” (for SALT BaTch) will be automatically added 
to the end of the filename. 

 
• Click the Save button and the selections are saved as a .SBT file. Note that only the selections are 

saved, not the names of the selected transcripts nor any data. 
 
10. Test out the saved selections. 
 

• Click Reset in the Rectangular Data File dialogue box to start over with. The only variable selected 
should be the transcript filename within “General Information”. Notice that reset did not remove 
the four transcripts you selected. 
 

• Select Open and you are presented with the “Open” dialogue box and, if necessary, change to the 
folder where you saved the RDF Selections.SBT file in step 9. 
 

• Select the file RDF Selections.SBT that you previously saved. Either double click the filename or click 
the filename once to select it and then click the Open button. 
 

• The same variables are selected. Click Cancel to exit the dialogue box without generating a new data 
file. 

 
D. More Data Selections 

 
1. Start over with new selections. 
 

• Select Window menu  Close All. If prompted to save any of the data sets, click No. 
 

 
• Click Reset in the Rectangular Data File dialogue box to start over. Do not save the current 

selections. 
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• The four transcripts should still be selected. If not, click Select Transcripts and reselect them. They 
are AA1Nar.slt, AA2Nar.slt, AA3Nar.slt and AA4Nar.slt. Refer back to section B in this exercise if 
you need help selecting them. 

 
2. The following variable sets are very similar to the Standard Measures Report variables and you should 

try them out on your own: Summary of Utterance Types, Syntax/Morphology Summary, Semantics 
Summary, Discourse Summary, Verbal Facility Summary, and Omissions and Error Codes. Look at some of 
the other variables. 

  
• Select Maze Distribution Tables 
 

Notice the “Length Measured in” and “Utterance Base” settings at the bottom of the dialogue box. 
The length setting specifies how the utterance and maze lengths are to be measured when 
generating the data – either in morphemes or in words. The utterance base setting determines 
which utterances to include – analysis set or total. The previous data sets, if appropriate, let you 
select from either the analysis set or total utterances. There wasn’t an utterance base setting. It is 
included here to simplify variable selection. If you want any of these variables based on both the 
current analysis set and on total utterances, you would have to run two different data sets and 
either cut-and-paste them together or work with them separately. 

 
• Select several distribution variables (your choice) and click OK. 
 
• Click Generate Data to generate the data set.  

 
3. Display the variable key. 

 

 
• Click Display Key to generate a key to the selected variable labels. The list is displayed behind the 

dialogue box. Click Cancel to close the dialogue box. Notice that each variable you selected is tagged 
with .MA, a reflection of the selected setting values: length in Morphemes, Analysis set utterances. 

 
• If you want to print the variable key, select File menu  Print.  

 
4. Change the target speaker setting. 

 
• It is a good policy to make the target speaker the 1st speaker. But sometimes there are multiple 

target speakers or you may be interested in the analyses of the other speaker. The target speaker 
setting is 1st speaker. Change this to 2nd speaker. 

 
• Click Generate Data to generate the new data set. The variables are now based on the 2nd speaker, 

although there is nothing in the report to indicate this. 
 
5. Select Window menu  Close All. If prompted to save any of the data sets, click No. 

 
6. Reset the target speaker and select Standard Word List variables. 
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• The target speaker setting is the 2nd speaker. Change this back to 1st speaker. 
 
• The Maze Distribution Tables variables are still selected. Since they are no longer needed, you 

should clear the selections. Select Maze Distribution Tables. 
 
• Click Reset to clear the selections and then click OK. 
 
• Select Standard Word Lists. There are two variables available for each word list. “Total” counts the 

combined number of occurrences of all the words in the list. “Types” counts the number of different 
words in the list which were used by the target speaker. Notice that the area is the main body and 
the utterance base is the analysis set. Also notice that there is a big gap between the last pronoun 
list and the “Yes and No Words”. These are placeholders for the user-defined standard word lists. 

 
• Select both total and types for several of these word lists (you choose the lists) and click OK. 
 
• Click Generate Data again to generate the data set. Each variable label ends with “.BA” which 

indicates the selected setting values: main Body, Analysis set utterances. Remember that if you 
want to know what variable any label represents, return to the Rectangular Data File dialogue box 
and display the variable key. 

 
7. Look at the Standard Utterance List variables. 

 

 
• The Standard Word List variables are still selected. You should reset them to simplify the next 

report. Select Standard Word Lists. 
 
• Click Reset to clear the selections and then click OK. 
 
• Select Standard Utterance Lists. These variables correspond to the utterances selected within the 

“Analyze menu  Standard Utterance Lists” option. Each variable represents the count of the 
utterances included in that list. 

 
• Try this out on your own. 

 
8. Select word exploration variables. 

 

 
• Click Reset to clear all the selections. Do not save the current selections. 

 
• Click the Explore button. These variables correspond to the Explore menu where you select words, 

codes, and/or utterances you are interested in.  
 

• The Utterance Base setting specifies which utterances to include when generating the word and 
utterance counts. Select Analysis Set (complete and intelligible verbal utterances by default). 

 
• Select Word and Code List to enter the list of words and/or codes you want counted. 
 
Get the list of personal pronouns from a file. 
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• Click Open. Unless you changed the default word and code list folder (My SALT Data\Lists folder 

within Documents), the Samples folder should be listed.  
 
• Open the Samples folder. 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Click the Personal Pronouns.LST file once to select it and then click the Open button. Or double click 
the filename. The following list of pronouns is displayed in the edit window: 

  HE 
  HER 
  HIM 
  I 
  IT 
  ME 
  SHE 
  THEM 
  THEY 
  US 
  WE 
  YOU 
 

Although you are entering a simple list of words, the same rules for entering a word list in the 
Explore menu apply here. For example, you may use wildcard characters (= and @) to specify sets of 
words or codes, and you may specify combinations of words and codes. Refer to the help option 
within this dialogue box for details.  

 
• Notice the three settings. 
 

1. The “Search area” setting indicates that these pronouns must be found in the Main body of the 
utterance (not in the mazes) to be counted. 
 

2. The “Match part for identified roots” setting determines which part of the word to match when 
words have been entered using the vertical bar to identify the root, e.g. “wented|go[EO:went]”. 
“Produced” refers to the part of the word preceding the vertical bar and “Identified” refers to 
the part of the word following the vertical bar. 
 

3. The “Code type for isolated codes” setting is used to determine the type of code to match when 
the code specified is isolated from a word or phrase, e.g., “[PR2]” as opposed to “that[PR2]”. 

Note: if the default word and code list folder has been changed, follow these steps to reset the folder 
to the default setting: 
▪ Click the Cancel button three times to close all the dialogue boxes and return to the transcript. 
▪ Select Setup menu  File locations  Word and Code Lists. The current word and code list folder 

is displayed. 
▪ Click the Reset button to reset the word and code list folder to the default setting. 
▪ Click OK. 
▪ You are asked if you want to save the folder setting as the program default. If you select Yes, the 

previous folder setting is lost. If you select No, the change is only in effect until you exit the SALT 
program. Select Yes or No. 

▪ Go back to the beginning of step 8 (above). 
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Since “Word or utterance codes” is selected, these isolated codes may be counted if they are 
either a word or utterance code. If the setting is “Word codes” and a code is specified in the list 
by itself, e.g., [PR2], it is only counted if it is a word code. And if the setting is “Utterance codes” 
then it is only counted if it is an utterance code. Word or utterance codes, the default setting, 
counts codes whether they are word codes or utterance codes. 

 
• Click OK to return to the “Explore” dialogue box. 

 
The other two buttons within the selection criteria section, “Standard Utterance Types” and 
“Utterance Length”, correspond to the same options within the Explore menu and are used to select 
utterances based on criteria such as ending punctuation or the existence of mazes and pauses, or 
utterance length measured in words or morphemes. 
 

• Although you have specified the word list, no variables have been selected. Notice that there are 
two sets of variables to select from: 

 
1. Summary Variable – one variable 

• Total Selected Utterances - counts the selected utterances, i.e., the total number of 
utterances which contain at least one personal pronoun. 

 
2. Word and Code List Item Variables – one variable for each item in the list 

• No. of Occurrences – counts the total number of times each word occurs 
• No. of Utts Containing Item - counts the number of utterances which contain each word 
• No. of Different Forms - counts the number of different forms each item has 
• No. of Different Words - counts the number of different word roots for each item 
• Presence or Absence – indicates whether or not each item is found (1=found, 0=not found) 
• Mentioned First – indicates whether or not each item is mentioned first by the target speaker 

(1=mentioned first, 0=not mentioned first, -1 if not used in transcript) 
 

Refer to the Help option in this dialogue box for a description, with examples, of each of these 
variables. 

 
• Check the Total Selected Utterances as the Summary Variable.  
 
• Check the No. of Occurrences as the Word and Code List Item Variable.  
 
• Click OK to exit the “Explore” dialogue box with the personal pronouns selected.  
 
• Click Generate Data to generate the report. The first variable “TotSelUt” is a count of the number of 

utterances. This counts the number of 1st speaker, analysis set utterances which contain at least one 
personal pronoun in the main body of the utterance. Following this variable are counts for the 
individual pronouns.  

 
E. Select Data from one of the SALT databases 
 

In addition to selecting data from sets of transcripts, the Rectangular Data File tool may be used to select 
data from the samples stored in the SALT databases, either those which come as part of the software or 
those you create from your own transcripts.  
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2. Click Reset to clear the selections. Do not save the current selections. 

 
3. Select the Play Database 

 
• Choose Select Transcripts and you are presented with the “Select Transcripts” dialogue box. 
• Click Clear to clear the previously-selected filenames 
• Click Browse for Built-in Database. Unless you changed the default database folder, the “Reference 

Databases” folder located within the ProgramData folder is displayed. 
• Select Play.sltdb from the list and click Open. When informed that 69 database transcripts were 

added, click OK to continue. 
• Click OK to close the “Select Transcripts” window. 

 
 
 
 
 
 
 
 
 

4. Select age and grade data 
 
• Click the Plus Lines button. 
• Select + CA: (yy;mm). 
• Select + CA: (in years). 
• Select + Grade: 
• When you have finished selecting these three variables, click OK. 

5. Select some Standard Measures Report variables. 
 
• Click the Standard Measures Report button. 
• Select MLU in Morphemes, Mean Verbs/Utterance, and SI Composite Score. 
• When you have finished selecting these variables, click OK. 

 
6. Click Generate Data to generate the results. There is a delay while the 69 database samples are scanned 

before the results are displayed.  
 

Note that all the samples from the database are used. In this example, the age and grade data can be used 
to select a subset of the samples once you import the data into a spreadsheet or statistical program. 
 

F. Close All Windows 
 

• Select Window menu  Close All. 
 
 
 

Note: if the default database folder has been changed, follow these steps to reset the database 
folder to the default setting: 
• Click the Cancel button three times to close the dialogue boxes. 
• Select Setup menu  File locations  Built-in Reference Databases. The current database 

folder is displayed. 
• Click the Reset button to reset the database folder to the default setting. 
• Click OK. 
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